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ABSTRACT 
 

Towers, J.R., Ford, J.K.B., and Ellis, G.M. 2012. Digital photo-identification dataset 
management and analysis: Testing protocols using a commercially available 
application. Can. Tech. Rep. Fish. Aquat. Sci. 2978: iv + 16 p. 

 
The conversion from analogue to digital formats in scientific photography has 

created a need for new photo management and analysis tools for some large datasets. In 
order to maintain continuity with metadata working standards used for long time series of 
photo-identification data on film, we managed and analyzed a multi-year dataset of over 
75,000 digital identification photos of killer whales using the program Photo Mechanic®.  
In this report, we provide detailed descriptions of our use of this application including 
setup, image filing, analysis and associated metadata input as well as metadata output, 
image searching and associated cataloguing.  Additionally, we outline some of the Photo 
Mechanic options not used in our study but that may be worthy of consideration for use in 
other photo-identification projects. 
 
 
 
 
 

RÉSUMÉ 
 
Towers, J.R., Ford, J.K.B. and Ellis, G.M. 2012. Digital photo-identification dataset 

management and analysis: Testing protocols using a commercially available 
application. Can. Tech. Rep. Fish. Aquat. Sci. 2978: iv + 16 p. 

 
Le passage de l'analogique au numérique en photographie scientifique soulève la 

nécessité de mettre en place de nouveaux outils de gestion et d'analyse photographique 
pour certains grands ensembles de données. Afin d'assurer la conformité avec les 
normes d'utilisation des métadonnées, suivies depuismps pour les ensembles de 
données d'identification photographique sur pellicule, nous avons géré et analysé un 
ensemble de données se rapportant à plus de 75 000 images d'identification 
photographique d'épaulards à l'aide du programme Photo Mechanic®.  Dans le présent 
rapport, nous donnons des descriptions détaillées de l'utilisation que nous faisons de ce 
programme, y compris la mise en place, le classement des images, l'analyse et la saisie 
connexe des métadonnées, la sortie de données,la recerche d'images et le catalogage 
pertinent.  De plus, nous décrivons certaines des options de Photo Mechanic qui n'ont 
pas servi à notre étude mais que l'on pourrait envisager d'utiliser dans d'autres projets 
d'identification photographique. 
 
 
 
 

  iv



1.0   INTRODUCTION 
 

The photo-identification of natural markings on individual wild cetaceans has 
been used as an important research method since the 1970s (Bigg et al. 1976; Würsig 
and Würsig 1977; Katona et al. 1979; Braham et al. 1980; Payne et al. 1981).  Data 
collected using photo-identification have been essential for determining population sizes 
and demographic trends (Bigg et al. 1990; Katona and Beard 1990; Hammond 1990; 
Olesiuk et al. 1990; Payne et al. 1990), as well as the distribution, range and migration 
patterns of many cetacean species (Darling and McSweeney 1985; Stone et al. 1987; 
Calambokidis et al. 1990; Dorsey et al. 1990; Goley and Straley 1994).  These studies 
were originally conducted using 35-mm film.  In recent years, many datasets of 
cetacean images obtained using film have been expanded with the inclusion of digitally-
obtained photographic data (Baird et al. 2008; Ellis et al. 2008; Calambokidis et al. 
2009; Aschettino et al. 2011; Ellis et al. 2011).  Other, recent studies on cetaceans have 
been undertaken using digital photographs exclusively (Jefferson et al. 2009; Tyurneva 
et al. 2009; Weir 2009; Auger-Méthé et al. 2010; Whooley et al. 2011).   

 
Photo-identification datasets can be relatively large and therefore require a 

standardized approach for data collection and specialized methods for data analysis 
and management.  Particular photo-identification methods vary by the species or 
population being studied (Lien and Katona 1990).  Photo-identification data 
management and analysis procedures for all species, however, can consist of relatively 
similar stages.  These stages usually include sorting or filing the images, identifying 
individuals within the frames and cataloguing the results (Mazzoil et al. 2004).  The 
ways in which these stages are accomplished differ depending on whether film or digital 
photo-identification data are being analyzed (Meyer 2007).  In either case, granular and 
structured metadata such as time, date, location, photographer, animal identity, photo 
rating and comments or keywords as they pertain to each identification photo need to 
be recorded in a consistent manner over the time series of the dataset.  Implementation 
of a metadata working standard is of great use when working with photo-identification 
data.  Applied to film, such a standard requires systematic use of data sheets that 
correspond to individual frames on a negative strip.  When working with digital images, 
adoption of a metadata working standard requires the use of metadata container fields 
such as those developed by the IPTC (International Press Telecommunications Council) 
(Adobe Systems Inc. et al. 2010). 

 
 Adhering to a metadata working standard, particularly as it pertains to recording 

individual animal identities for each photographic frame, is important for our long-term 
photo-identification study of killer whales.  This study was originally conducted using 
film.  An average of 7,500 film-based identification photos were collected and analyzed 
each field season from 1973 to 2008.  Due to this large volume of photographic data, 
efficient and consistent photo analysis techniques including the associated entry of 
metadata were developed early in the study and adhered to through its duration (Ellis, 
unpubl. data).  With the advancement of digital photographic technology in the past 
decade, our use of film-based photo-identification data management and analysis 
protocols declined while our use of digitally-based methods increased.  Although digital 



 

photo-identification techniques were relatively simple to adopt (Ellis et al. 2011), 
subsequent digital data analysis and management methods required more rigorous 
development in order to progressively parallel analysis and management methods used 
for the corresponding film dataset.  

 
 In this report, we describe protocols that we developed to manage and analyze 
digital identification photos of killer whales with the application Photo Mechanic. These 
protocols were developed to enhance management of the digital photo-identification 
dataset and maintain consistency with methods we used for the analysis of over 
200,000 identification photos of killer whales on film from 1973 to 2008.  Details on 
setting up this application to accommodate these methods are provided.  Management 
and analysis are broken down into stages.  These stages consist of image organization, 
analysis and the associated application of metadata as well as metadata exporting, 
search techniques and subsequent image cataloguing.  Screenshots are used to help 
portray these methods.  We also discuss our use of this program and provide further 
tips on ways that Photo Mechanic could be useful for other photo-identification studies. 
 
  
  

2.0 PROGRAM DISPLAY SETUP 
 
 Photo Mechanic (version 4.6.8) was installed on Macintosh computers.  (This 
application runs almost identically on Windows XP® or Windows 7® operating 
systems).  In the Contact Sheet window toolbar, thumbnails were set to display from 5 
to 7 across depending on the size of the monitor screen being used.  Also in this 
toolbar, thumbnails were set to appear sorted by Capture Time, ensuring that images 
were displayed in the order in which they were taken.  From the Contact Sheet section 
of the Preferences window found under the Photo Mechanic menu, thumbnail labels 
were set to display the image Filename plus the contents of the standard IPTC 
metadata container field Caption by typing the variable for the Caption field in the space 
provided (Figure 1).  (A table of all metadata variables can be found beginning on page 
52 of the Photo Mechanic 4.6.3 Manual [Rains and Baker 2009].)  This IPTC metadata 
container field was used for individual Animal ID(s) so that after analysis this information 
was displayed under each thumbnail in the Contact Sheet view along with its Filename.  
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Figure 1.  Setting thumbnail labels to display Filename plus Caption field contents.  
 
 
 
 Setting photo information text preferences allowed only relevant metadata to be 
displayed with each image.  These preferences were set by opening the Set Info Text 
window in Settings under the Edit menu.  Relevant existing metadata such as Date, 
Time, and camera settings as well as post-analysis metadata such as Photographer, 
Location, Animal ID(s), Photo Rating, Comments, Analyst and Date Analyzed were 
chosen to be displayed by providing the variable for each corresponding IPTC metadata 
container field (Figure 2).  These metadata were shown in the Preview window (Figure 
3). They could also be displayed in the Contact Sheet view upon placement of the 
cursor over a thumbnail by checking Show Info Tooltips found under the View menu. 
 

 
 
Figure 2.  The Set Info Text window with existing and modified IPTC metadata container 

field headers and corresponding variables.  
 
 
 

A Preview window was opened for a photo by double-clicking on a thumbnail.  
The Preview window was set to display one image only by selecting the appropriate 
icon from the toolbar (Figure 3).  This display includes image metadata text and a zoom 
function on the right-hand side.  A full view of one image excluding photo info text was 
also occasionally used by selecting the appropriate icon from the toolbar.  Viewing 
images two at a time and having the ability to proceed forward or backward through the 
image set within the folder from either image on display was also an option in the 
toolbar but was not used.  This option, however, could be very helpful in the process of 
manually matching individuals within an image set.  
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Figure 3.  The Preview window.  
 
 
 

3.0 DATASET MANAGEMENT AND ANALYSIS 
 
3.1 IMAGE FILING 
 

For filing purposes, all folders for images of each encounter were named using a 
string sequentially consisting of a Population Code, Date, Photographer and Location all 
separated by underscores (i.e., KWT_2010-06-30_JTowers_JohnstoneStrait).  For 
consistency purposes, all folders containing identification images were stored on a 
secure server that is backed-up regularly.  Any images that were not in jpeg format were 
converted to jpegs prior to analysis.  Image files were renamed to reflect the folder 
name string followed by an underscore and the original file number.  Photo Mechanic 
provided for the streamlining of this and other processes with its Ingest option.  The 
Ingest window was set to open when Photo Mechanic detected an external source 
containing digital images.  Alternatively, the Ingest window was occasionally opened 
manually and then applied to a selected folder.  The folder and images inside were 
renamed during the Ingest process by providing the necessary strings in the necessary 
fields within the window (Figure 4).  The original file numbers were extracted during this 
process by applying the appropriate variable to the end of the new Filename string 
(Figure 4).  (Details on variable sub-string extraction can be found on page 51 of the 
Photo Mechanic 4.6.3 Manual [Rains and Baker 2009].)  Alternatively, a new series of 
file numbers were created using the sequence variable when original file numbers were 
non-existent or inconsistent.  Images were occasionally not renamed with Ingest.  In 
these cases they were renamed after being displayed in the Contact Sheet window by 
selecting all photos and then opening the Rename Photos window from under the File 
menu.  
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Figure 4.  The Ingest window showing different settings, including folder name and 

image rename string followed by the variable used for retention of original file 
numbers.  

 
 
 
3.2 METADATA INPUT AND IMAGE ANALYSIS 
 
 Batch entry of Photographer, Location and Analyst metadata to all photos in the 
encounter were also applied during Ingest or occasionally by selecting all images within 
the Contact Sheet window and opening the IPTC Stationary Pad from under the Image 
menu.  Existing IPTC metadata container fields were used for these metadata with the 
exception of Analyst for which the field Caption Writer was used (Figure 5).  Nominal 
Location names were entered, however, Photo Mechanic also allows for GPS 
coordinates to be applied to images.  This can be done manually by opening the Set 
GPS Coordinates window under the Image menu and then using the Google Earth® 
application within to find coordinates and apply them to selected images as necessary.  
Alternatively, GPS coordinates can be added by selecting all images and then opening 
the Import GPS Coordinates window found under the File menu.  In this window a GPX 
file can be imported, plotted, and the data within applied to images based on matching 
times between images and track points (Figure 6).  Variables for latitude and longitude 
can then be added to the previously mentioned Info Text to display these metadata. 
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Figure 5.  The IPTC Stationery Pad window showing metadata container fields including 

the 3 used for Analyst, Location and Photographer.  
 
 
 

 
 
Figure 6.  The Import GPS Coordinates window showing plotted GPX file.  
 
 
 
 It was sometimes necessary to edit existing Time and Date metadata if the 
source camera's Date and/or Time were incorrectly set.  In these cases the Adjust 
Capture Dates and Times window from under the Tools menu was opened (Figure 7).  
A new Date or Time was then set and applied to selected images as necessary. 
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Figure 7.  The Adjust Capture Dates and Times window.  
 
 
 
 Other metadata such as Animal ID(s), Photo Rating and Comments were applied 
respectively to the Caption, Headline and Keywords IPTC metadata container fields.  
Any photos that shared common characteristics noticeable at the thumbnail size were 
selected for batch entry of such metadata.  Multiple images of the same individual were 
commonly selected for batch metadata entry of Animal ID.  As killer whales in British 
Columbia have historically been monitored and identified from photographs of 
individuals’ left sides (Bigg et al. 1987; Ford et al. 1994; Ford and Ellis 1999; Ford et al. 
2000; Ellis et al. 2007; Ellis et al. 2008; Ellis et al. 2011), it was assumed in the 
metadata that images were of left sides unless otherwise stated.  Therefore, images of 
right sides were also commonly selected for batch entry of these metadata in the 
Comment field.  All other metadata were applied manually one frame at a time.  This 
was done by selecting the Edit IPTC Information icon from the Preview window toolbar, 
thereby opening the IPTC Info data application and display window over top of the 
existing Preview window (Figure 8).  Animal ID(s) were applied to the Caption field of 
every image containing one or more identifiable animals (Figure 8).  Identification 
names of more than one animal in a single frame were applied separated by a space.  A 
quality rating of 1 to 4 (with 4 being best) was applied to the Headline field only to 
images that were of a quality sufficient to be used as reference material (Figure 8).  
Comments were applied in the Keywords field of any images containing specific 
subjects or features. (Figure 8).  Multiple Comments in a single frame were applied 
separated by a comma and a space.  Comments were not made for descriptive 
markings on animals in our study, however, if a consistent vocabulary for these traits 
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were used during the metadata input and image searching stages, Photo Mechanic 
could be utilized as a non-metric based matching program.  After metadata were 
applied, the Save and Move to Next Photo command was selected from the icon or by 
using a keyboard shortcut (Keyboard shortcuts can be found beginning on page 159 of 
the Photo Mechanic 4.6.3 Manual [Rains and Baker 2009].) 
 

 
 
Figure 8.  The IPTC Info metadata application window showing the Comment list and 

other metadata applied to various container fields.  
   
 
 
3.3 METADATA OUTPUT 
 

After analysis and metadata embedding were completed for each photo obtained 
during an encounter, all images were selected for export of their embedded metadata.  
The desired IPTC metadata container field variables separated by tabs were entered 
into the Export Code field within the Exporter window selected from under the File menu 
(Figure 9).  The following code:  

 
{filenamebase}{tab}{yr4}{tab}{mn0}{tab}{day0}{tab}{h24}:{min}{tab}{location}{tab}{

photographer}{tab}{caption}{tab}{head}{tab}{keyw}{tab}{cwrt}{tab}{tday}  
 
yielded Filename, Date, Time, Location, Photographer, Animal ID(s), Photo Rating, 
Comments, Analyst, and Date Analyzed for all images within an encounter folder 
selected for metadata text export.  Each export file was renamed with the same string 
as the encounter folder from which it was derived and then stored in a folder including 
all other export files from that year.  Export files were then opened with the database 
application FileMaker Pro®. (Export files could also be opened with Microsoft Access®).  
Visual scans for erroneous data were performed on the files immediately after 
completion of encounter analysis and export.  When erroneous metadata were 
encountered, they were immediately corrected manually and then re-exported to 
overwrite the existing erroneous file.  All files were ultimately imported into a master 
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external database for all digital image metadata from all encounters with killer whales.  
The master database was used as an external metadata library.  Individual or multiple 
fields could be queried to aid in finding data totals or specifics.  Additionally, it provided 
for the safe-keeping of metadata in an organized manner. 
 

 
 
Figure 9.  The Export window showing Export Code consisting of individual tab 

separated IPTC metadata container field variables.  
 
 
 
3.4 IMAGE SEARCHING AND CATALOGUING 
 
 For image cataloguing purposes, searches for embedded metadata were 
performed when all photos to be searched could be found on one or more hard drives or 
servers.  Searches were conducted for specific metadata in IPTC metadata container 
fields by using the Search window under the Edit menu in Photo Mechanic (Figure 10).  
All resulting images were provided in a new folder.  This process represented an 
improvement over external metadata searches, as it negated the need to follow the path 
to each image location manually in order to verify its potential as high quality reference 
material in comparison to others.  Selected search results were saved into folders 
containing only high quality identification images of individual whales.  These folders, 
each named with the identity of the whale, were created for every individual and 
provided for quick future reference of the best identification images for each animal.  
Filenames inside were edited to begin with the name of each whale.  For quick 
reference of all individuals in the population, the single best image of each whale could 
be copied to a population folder that when opened with Photo Mechanic and sorted by 
Filename could provide a Contact Sheet view of all individuals in alphanumeric 
sequence.   
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Figure 10.  The Search window showing IPTC metadata container field search criteria.  
 
 
 
 A more restricted search could be applied to multiple IPTC metadata container 
fields of images within a single folder by using the Find window selected from under the 
Edit menu when the desired folder is open.  The Find and Replace window also found 
under the Edit menu could be used to locate and correct erroneous data from any IPTC 
metadata container field(s) of images within the encounter.  Similar functions could also 
be performed to the externalized metadata text within the master database using 
Filemaker Pro.   
 
 
 

4.0 DISCUSSION 
 

The complete transition from film to digital methodology for our long-term photo-
identification studies of killer whales off the west coast of North America was inevitable 
due to the many advantages that digital technology offers over film.  Standardizing the 
use of digital technology and the management and analysis of digital data were critical 
steps in undertaking the shift between the two analogous methods.  In order for any 
analysis methods used for digitally-sourced data to correspond with those used 
traditionally with film-based data, we required an application that could be used to apply 
different metadata to individual images.  Finding a program that accelerated workflow, 
was regularly updated, could rename files and be used to edit, export and search for 
metadata were also important criteria for us to consider during the transition to digital 
technology for our photo-identification studies. 
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A total of 76,448 digital identification photos from 1,689 encounters with killer 
whales from 2001 to 2010 were managed and analyzed with Photo Mechanic using the 
protocols outlined in this report.  Our use of digital cameras and digital photo-
identification data management and analysis protocols gradually increased over these 
years while our use of film for the photo-identification of killer whales gradually 
decreased until ceasing altogether in 2008.  When compared to the multiple steps and 
associated time needed to manage and analyze photo-identification data from film we 
found that managing and analyzing digital photo-identification data with Photo Mechanic 
greatly expedited and streamlined the entire process.  While doing so, this application 
still allowed for consistency of baseline analysis protocols between the two mediums to 
be maintained. 

 
The idea of using metadata as a means to better organize and find images is not 

new.  Metadata working procedures are in use in many industries today and are 
paramount to keeping image copyright, caption and keyword data intact across 
platforms and during transport and edit.  The adoption or creation of a metadata working 
standard for the maintenance of a dataset consisting of cetacean photo-identification 
images allows for its safe-keeping and long-lasting preservation, and helps to ensure 
that the dataset can be mined for specific results with ease.  Many digital image 
programs on the market today cater towards users wishing to implement metadata 
working standards.  The program Photo Mechanic, however, fit our requirements better 
than other programs that we tested such as ACDSee®, iPhoto®, Photoshop®, 
Lightroom®, Aperture® and IMatch®.  
 
  Although much of what is described in this report can be gleaned by filtering 
through Photo Mechanic software features as described by Rains and Baker (2009) and 
applying them accordingly to a dataset of identification photos, the concept and benefit 
of doing so may not be immediately apparent.  Various publications explain the use of 
digital photography (Mazzoil et al. 2004) and specially designed matching programs 
(Mizroch et al. 1990; Whitehead 1990; Araabi et al. 2000; Huele et al. 2000; Hillman et 
al. 2003; Mazzoil 2004; Gope et al. 2005; Adams et al. 2006; Kniest et al. 2010) for 
studies of cetaceans.  Further publications provide examples of digital photo dataset 
management and metadata working techniques (Krogh 2009; Nozères 2011). Few, 
however, provide thorough examples of the management and analysis of a dataset of 
digital cetacean identification images that complements protocols used historically for 
film.   
 
 The methods and protocols outlined in this report can also be helpful for other 
studies when modified or adapted to suit the needs of the user and the dataset.  For 
example, descriptive metadata from a pre-determined vocabulary of keywords used to 
flag specific physical features of an animal can be applied to various IPTC metadata 
container fields, similar to protocols outlined by Harting et al. (2004).  Searches can 
then be made in those metadata container fields for such keywords, thereby providing 
non-metric based potential matches.  Using metadata in similar ways can also be 
helpful in studies that are not based on digital photo-identification.  The concepts and 
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protocols described in this report can be adapted and modified for application to 
datasets of video and acoustic files as well. 
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